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1 INTRODUCTION 

1.1 Purpose 

The Sentinel-3 Ocean and Land Colour Instrument (OLCI) Marine Handbook is a user guide 
that summarises the key information needed to enable an end-user (both general and specialist) 
to understand the marine Level 1B (L1B) and Level 2 (L2) products. The handbook is aimed 
at all current and potential users of the Copernicus Marine Data Stream that are interested in 
the Sentinel-3 ocean colour products for use in the open-ocean, coastal domain and inland 
waters.  

1.2 Scope 
The handbook includes information on the components of the instrument system for OLCI, the 
specifics of measurement techniques used, details on applied corrections and the processing 
steps required to derive geophysical variables. The capability of the system is discussed in the 
context of its complementarity with, and improvements on, other ocean colour missions, with 
notes on existing limitations. A discussion of file formats, processing tools and data-access 
routes precedes a presentation of available support resources. Where the detail is not held in 
the handbook itself, the user is pointed to further (primarily internet-based) resources. 

1.3 Document Structure 
 
Section 1 General information (this section) 
 
Section 2 Background information on EUMETSAT, the Copernicus programme and the 

aims of the Sentinel-3 mission. 
 
Section 3  Provides an overview of Copernicus, historical ocean colour missions, and the 

contribution of Sentinel-3 OLCI instrument. 
 
Section 4 Gives an overview of the OLCI instrument, coverage, quality, capability and 

accuracy  
 
Section 5 Gives a description of OLCI L1 and L2 marine processing. 
 
Section 6 Gives a description of OLCI L1 and L2 marine products. 
 
Section 7 Explains how to access and visualise OLCI data, and where to find help. 
 
Section 8 Description of the data quality. 
 
Section 9 Explains how to find information concerning updates to processing baselines and 

reprocessing campaigns. 
 
Section 10 Frequently Asked Questions, providing information on anomalies and other 

information not covered elsewhere. 
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1.4 Applicable Documents 
Applicable documents incorporate additional provisions to the source document. A provision 
may be in the form of requirements, statements, instructions or recommendations. 

AD-1 Sentinel-3 Mission Requirements Document, v2.0 EOP-SMO/1151/MD-md 

AD-2 Sentinel-3 Mission Requirements Traceability 
Document, v1.0 

EOP-SM/2184/CD-cd 

1.5 Reference Documents 
Reference documents contain additional information related to this document. 
 
RD-1 IOCCG Report 10 (2010). Atmospheric Correction 

for Remotely-Sensed Ocean-Colour Products. 
ISBN: 978-1-896246-61-1 

RD-2 Morel and Gentili. 1996. Diffuse reflectance of 
oceanic waters.   

doi: 
10.1364/AO.35.004850 

RD-3 Morel et al. 2002. Bidirectional reflectance of 
oceanic waters: accounting for Raman emission and 
varying particle scattering phase function. 

doi: 
10.1364/AO.41.006289 

RD-4 Antoine. 2010. OLCI Level 2 Algorithm Theoretical 
Basis Document: Ocean Colour Products in Case 1 
waters 

S3-L2-SD-03-C10-LOV-
ATBD 

RD-5 Siegel et al. 2005. Colored dissolved organic matter 
and its influence on the satellite-based 
characterization of the ocean biosphere 

doi: 
10.1029/2005GL024310 

RD-6 IOCCG Report 13. 2012. Mission Requirements for 
Future Ocean-Colour Sensors. 

ISBN: 978-1-896246-64-2 

RD-7 Donlon et al. 2012. The Global Monitoring for 
Environment and Security (GMES) Sentinel-3 
mission. 

doi: 
10.1016/j.rse.2011.07.024 

RD-8 Antoine and Morel, 1999. A multiple scattering 
algorithm for atmospheric correction of remotely 
sensed ocean color (MERIS instrument): principle 
and implementation for atmospheres carrying 
absorbing aerosols. 

International Journal of 
Remote Sensing, Vol. 20 

RD-9 Moore et al. 1999. The atmospheric correction of 
water colour and the quantitative retrieval of 
suspended particulate matter in Case II waters: 
application to MERIS. 

International Journal of 
Remote Sensing, Vol. 20 

RD-10 Moore, G., C. Mazeran and J.-P. Huot, 2017. Case 
II. S Bright Pixel Atmospheric Correction. MERIS 
ATBD 2.6, Issue 5.3. (mesotrophic to high turbidity) 

https://www.eumetsat.int/o
cean-colour-resources 

RD-11 Aiken and Moore. 1997. Photosynthetic Available 
Radiation, v5 

MERIS ATBD 2.18 
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RD-12 Morel et al. 2007. Examining the consistency of 
products derived from various ocean color sensors in 
open ocean (case 1) waters in the perspective of a 
multi-sensor approach. 

doi: 
10.1016/j.rse.2007.03.012 

RD-13 Doerffer and Schiller. 2007. The MERIS Case 2 
water algorithm.  

 

doi: 
/10.1080/01431160600821
127 

RD-14 Lindstrot et al. 2012. 1D-Var retrieval of daytime 
total columnar water vapour from MERIS 
measurements. 

doi: 
10.5194/amt-5-631-2012 

RD-15 Sentinel-3 Calibration and Validation Plan, v1.0 S3-PL-ESA-SY-0265 

RD-16 INSITU-OCR. 2012. International Network for 
Sensor Inter-comparison and Uncertainty 
assessment for Ocean Color Radiometry (INSITU-
OCR).    

http://www.ioccg.org/grou
ps/INSITU-OCR_White-
Paper.pdf 

RD-17 Mazeran et al. 2017. Requirements for Copernicus 
Ocean Colour Vicarious Calibration 
Infrastructure. v2.1  

https://www.eumetsat.int/O
C-SVC 

RD-18 Bonekamp et al. 2016. Core operational Sentinel-3 
marine data product services as part of the 
Copernicus Space Component. 

doi: 
/10.5194/os-12-787-2016 

RD-19 Sentinel 3 PDGS File Naming Convention, v1D  EUM/LEO-
SEN3/SPE/10/0070 

RD-20 OLCI Level 1 Algorithm Theoretical Basis 
Document, v4.0 

S3-ACR-TN-007 

RD-21 Product Data Format Specification – OLCI Level 1 
& Level 2 Instrument Products, v1.10  

S3IPF.PDS.004 

RD-22 O'Reilly et al. 1998. Ocean Color Chlorophyll 
Algorithms for SeaWiFS. 

Journal of Geophysical 
Research, 103(C11). 

RD-23 The Global Observing System for Climate: 
Implementation Needs (GCOS-200, GOOS-214). 

2016 

RD-24 Sentinel-3 OLCI L2 report for baseline collection 
OL_L2M_003 

https://www.eumetsat.int/m
edia/47794 

   

RD-25 Sentinel-3 OLCI Chlorophyll Index switch for low-
chlorophyll waters. I. Cazzaniga and E. 
Kwiatkowska  
 

OLCI L2 ATBD, 
EUM/RSP/DOC/18/102836
0, 2020, 
https://www.eumetsat.int/m
edia/47752  
 

RD-26 Chlorophyll algorithms for oligotrophic oceans: A 
novel approach based on three‐band reflectance 
difference. C. Hu, Z. Lee, and B.A. Franz  

J. Geophys. Res., 117, 
C01011, doi: 
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 10.1029/2011JC007395, 
2012.  
 

RD-27 VIIRS-derived chlorophyll-a using the ocean color 
index method. M. Wang and S. Son  
 

Remote Sensing of 
Environment 182: 141–149, 
2016.  
 

RD-28 SeaBASS, Bio-optical Archive and Storage 
System, NASA Ocean Biology Processing Group  
 

https://seabass.gsfc.nasa.g
ov/  
 

RD-29 Effective reflectance of oceanic whitecaps. P. 
Koepke.  
 

Appl. Opt., 23, 1816– 1824, 
1984.  
 

RD-30 
 

Ocean Colour Turbid Water. OLCI Level 2 
Algorithm Theoretical Basis Document. Roland 
Doerffer  
 

S3-L2-SD-03-C11-GKSS-
ATBD, 2010, 
https://www.eumetsat.int/m
edia/38636  
 

RD-31 Uncertainty estimation of case2 water IOP products 
of OLCI using artificial neural networks. Roland 
Doerffer  
 

2019, 
https://www.eumetsat.int/m
edia/43613  
 

RD-32  S3IPF PDS 007.2 - i2r11 - Auxiliary Data Format 
Specification - OLCI Level 2 

2021, 
https://www.eumetsat.int/m
edia/47943 

RD-33 Sentinel-3: Mission Requirements Document, M.R 
Drinkwater and H. Rebhan (MRD) 

EOP-SMO/1151/MD-md, 
Feb 
2007, 
http://esamultimedia.esa.in
t/docs/ 
GMES/GMES_Sentinel3_
MRD_V 
2.0_update.pdf 
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1.6 List of Abbreviations, Acronyms and Symbols 

AAC Alternative Atmospheric Correction 
AC Atmospheric Correction 
ADC Analogue to digital converter 
ATBD Algorithm Theoretical Basis Document 
BAC Baseline Atmospheric Correction 
BPAC Bright Pixel Atmospheric Correction 
BRDF Bidirectional Reflectance Distribution Function 
C2RCC Case 2 Regional / Coast Colour processor 
Cal/Val Calibration and Validation 
CCD Charge-Coupled Device 
CDOM Coloured or Chromophoric Dissolved Organic Matter 
CI Chlorophyll Index 
CMEMS Copernicus Marine Environment Monitoring Service 
CODA Copernicus Online Data Access 
CZCS Coastal Zone Color Scanner 
ECMWF European Centre for Medium-Range Weather Forecasts 
ECV Essential Climate Variables 
EO Earth Observation 
ESA European Space Agency 
EUMETSAT European Organisation for the Exploitation of Meteorological Satellites 
FOV Field Of View 
FR Full Resolution 
FTP File Transfer Protocol 
FWHM Full Width at Half Maximum 
GCOM-C Global Change Observation Mission - Climate 
GCOS Global Climate Observation System 
H2O water 
IOCCG International Ocean Colour Coordinating Group 
IOPs Inherent Optical Properties 
IWV Integrated Water Vapour column 
L1 Level 1 
L1B Level 1B 
L2 Level 2 
L3 Level 3 
MERIS Medium Resolution Imaging Spectrometer 
MODIS Moderate Resolution Imaging Spectroradiometer 
MRD Mission Requirements Document 
MRTD Mission Requirements Traceability Document 
MWR MicroWave Radiometer 
NASA National Aeronautics and Space Administration 
netCDF Network Common Data Format 
NIR Near Infrared 
NO2 nitrogen 
NOAA National Oceanic and Atmospheric Administration 
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NRT Near Real-Time, delivered to the users less than 3 hours after acquisition of 

the data by the sensor 
NTC Non-Time Critical products are delivered not later than 1 month 

(commitment) after acquisition or from long-term archives. Typically, 
available within 24 or 48 hours. 

O2 oxygen 
O3 ozone 
OAA   Observation (viewing) Azimuth Angle 
OC4Me Ocean Colour for MERIS 
OCM Ocean Colour Monitor 
OCTS Ocean Color Temperature Scanner 
ODA Online Data Access 
OES Ocean Ecology Sensor 
OLCI Ocean and Land Colour Instrument 
OZA  Observation (viewing) Zenith Angle 
PACE Pre-Aerosols Clouds and ocean Ecosystems 
PAR Photosynthetically Active Radiation 
PDGS Payload Data Ground Segment 
POD Precise Orbit Determination 
RR Reduced Resolution 
S3VT Sentinel-3 Validation Team 
SAA  Solar Azimuth Angle 
SAFE Standard Archive Format for Europe 
SeaWiFS Sea-viewing Wide Field-of-view Sensor 
SLSTR Sea and Land Surface Temperature Radiometer 
SNAP SeNtinel Application Platform 
SNR Signal-to-Noise Ratio 
SRAL SAR Radar Altimeter 
SSH Sea Surface Height 
SST Sea Surface Temperature 
STC Short-Time Critical, not relevant to OLCI 
STEP Science Toolbox Exploitation Platform 
SVC System Vicarious Calibration 
SWH Significant Wave Height 
SZA  Solar Zenith Angle 
TOA Top Of Atmosphere 
TSM Total Suspended Matter concentration 
VIIRS Visible Infrared Imaging Radiometer Suite 
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2 BACKGROUND  

2.1 The Copernicus Programme 

Copernicus is the European programme for the establishment of a European capacity for Earth 
observation and monitoring. The programme aims to deliver information services based on 
satellite and in situ (non-space) components. The Copernicus Programme is coordinated and 
managed by the European Commission. It is implemented in partnership with the Member 
States, the European Space Agency (ESA), the European Organisation for the Exploitation of 
Meteorological Satellites (EUMETSAT), the European Centre for Medium-Range Weather 
Forecasts (ECMWF), EU Agencies and Mercator Océan. The Copernicus programme provides 
users with free, full and open access to environmental data. 
 
The satellite component of the Copernicus Programme encompasses the Sentinel satellite 
missions, including Sentinel-3. Sentinel-3 is dedicated to providing high-accuracy optical and 
radar altimetry data for marine, land and atmosphere services. EUMETSAT operates the 
Sentinel-3 satellite series, with ESA support, and is responsible for delivering the Sentinel-3 
marine data stream and near-real-time atmospheric products. Looking ahead, EUMETSAT will 
also operate and deliver products from the Sentinel-4, and Sentinel-5 instruments, and the 
Sentinel-6/Jason-CS satellites, providing further atmosphere and ocean services. 

2.2 European Organisation for the Exploitation of Meteorological Satellites 
(EUMETSAT) 

 
Founded in 1986, EUMETSAT is a European-based and globally-focussed intergovernmental 
operational satellite agency. Its purpose is to gather accurate, reliable and timely satellite data 
on weather, climate and the environment, and to deliver this to its Member and Cooperating 
States, international partners, and to users world-wide. With a strategic goal to ensure 
improvements in, and continuity of, satellite observations, EUMETSAT oversees the 
development and operation of a range of complex satellite systems that are in constant use in 
monitoring weather, climate, the oceans and the atmosphere, and supports downstream services 
such as meteorological forecasting, air-travel safety and shipping. 
 
EUMETSAT operates a fleet of satellites in geostationary and polar orbit from its Mission 
Control Centre (MCC), based at its headquarters in Darmstadt, Germany. The geostationary 
Meteosat platforms provide regular imagery over Europe, Africa and the adjacent seas, 
(Meteosat-9, 10 and 11), and over the Indian Ocean (Meteosat-8). More detailed observations 
of the global atmosphere, oceans and continents are provided by the three polar-orbiting Metop 
satellites. In partnership with NOAA, CNES and NASA, EUMETSAT supports the operational 
phase of the Jason-3 and Sentinel-6/Jason-CS reference altimeters, providing near real-time 
ocean topography products to support ocean forecasting and climate analysis. 
 
Under the Copernicus Programme, EUMETSAT provides Earth Observation (EO) data, 
products and support services to the Copernicus information services and user communities, 
with a focus on marine, atmosphere and climate. In the marine context, this role encompasses 
operating the Sentinel-3, Jason-3 and Sentinel-6/Jason-CS satellites. The marine capability of 
the Sentinel-3 OLCI instrument is the sole focus of this document. 
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2.3 Sentinel-3 objectives 
 
Sentinel-3 is a dedicated Copernicus satellite delivering high-quality ocean measurements. In 
the marine environment, the primary objective of Sentinel-3 is to determine ocean-surface 
colour parameters, sea-surface topography, sea-surface temperature; offering EO data with 
global coverage every two days (with two satellites) in support of marine applications, and with 
near real-time products delivered in less than three hours. 
 
Sentinel-3A and 3B were launched in February 2016 and April 2018, respectively. In its 
commissioning phase, Sentinel 3B flew in tandem with Sentinel 3A, 30 seconds apart on the 
same orbital track. Sentinel-3B transitioned to its final orbital track and entered its operational 
phase in autumn 2018. In the longer term, the Sentinel-3 mission will have further satellites 
(Sentinel-3C and Sentinel-3D), to extend the time series for this global monitoring. 
Requirements of the Sentinel-3 mission related to OLCI instrument include: 
 

• Visible and Near-Infrared radiances (‘Ocean Colour’) for oceanic, coastal and inland 
waters, determined to an equivalent level of accuracy and precision as MERIS data, 
with complete Earth coverage in two to three days, and co-registered with SST 
measurements. 

 
Other requirements of the Sentinel-3 mission, not related to OLCI - but to other instruments on 
the platform(s) - include: 
 

• Sea surface temperature (SST) determined globally to an equivalent accuracy and 
precision as that presently achieved by A/ATSR (i.e. <0.3 K), at a spatial resolution of 
1 km (SLSTR). 

• Sea surface height/topography (SSH) and, significant wave height (SWH) over the 
global ocean to an accuracy and precision exceeding that of Envisat RA-2 (SRAL). 

 
For more information, users should consult the specific objectives for the Sentinel-3 mission. 
These are defined in the Mission Requirements Document (MRD) [AD-1], which is adopted 
in a traceable format through the Mission Requirements Traceability Document (MRTD) [AD-
2].  
 
Within the Copernicus framework, the major user of Sentinel-3 marine products is the 
Copernicus Marine Environment Monitoring Service (CMEMS). CMEMS provides regular 
and systematic core reference information on the state of the physical and biological oceans 
and regional seas to support marine applications. The products come from EO data (including 
Sentinel-3), in situ measurements and numerical modelling, and are made available via the 
CMEMS website1. 

2.4 Disclaimer 
The use of these products is granted to every interested user, free of charge. 
 

                                                   
1 CMEMS: http://marine.copernicus.eu/ 

http://marine.copernicus.eu/
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EUMETSAT is interested in receiving your feedback; we would appreciate your 
acknowledgment in any usage of, and publications concerning the data, and would like to 
receive copies of any publications released. Your feedback helps us in improving product 
quality and maintaining the resources for the EUMETSAT marine data services. Feedback can 
be provided through the EUMETSAT user helpdesk (ops@eumetsat.int). 
 
 

2.5 Useful links  
EUMETSAT Copernicus homepage: 
https://www.eumetsat.int/who-we-work/copernicus 
EUMETSAT ocean-colour homepage: 
https://www.eumetsat.int/ocean-colour-services  
EUMETSAT training:  

https://training.eumetsat.int/ 
 
EUMETSAT YouTube home: 

https://www.youtube.com/channel/UCiN59j5b1fAGnXVzIYFpaMw 
 
Copernicus YouTube playlist: 

https://www.youtube.com/playlist?list=PLOQg9n6Apif1ODObv39j43j8IAvJDOAVY 
 
How to access Copernicus ocean colour data: 

https://youtu.be/V3NAuafvlFM 
 
Meet the Satellite: Sentinel-3: 
https://www.youtube.com/watch?v=ZRxB5mSassg&list=PLOQg9n6Apif1ewrVmKRcyBaIN
2jkxjYAv 
 
Atlantic Ocean Colour: 

https://youtu.be/n2hpWMRWfr0  
 
Sentinel-3 for oceans: 

https://www.youtube.com/watch?v=T9WCWnk_qN4 
 
Sentinel-3 playlist: 

https://www.youtube.com/playlist?list=PLbyvawxScNbus9n8rmw0GElhPqrCwcsiD 

2.6 History of product changes  
A history of changes to products can be found in the relevant product notices and specification 
documents via the following link: 

https://www.eumetsat.int/ocean-colour-services  
Further details on the status of the Sentinel-3 mission can be found via the data quality reports 
at the following link:  
https://sentinels.copernicus.eu/web/sentinel/technical-guides/sentinel-3-olci/data-quality-
reports  

https://training.eumetsat.int/
https://www.youtube.com/channel/UCiN59j5b1fAGnXVzIYFpaMw
https://www.youtube.com/playlist?list=PLOQg9n6Apif1ODObv39j43j8IAvJDOAVY
https://youtu.be/V3NAuafvlFM
https://youtu.be/n2hpWMRWfr0
https://www.youtube.com/watch?v=T9WCWnk_qN4
https://www.youtube.com/playlist?list=PLbyvawxScNbus9n8rmw0GElhPqrCwcsiD
https://sentinels.copernicus.eu/web/sentinel/technical-guides/sentinel-3-olci/data-quality-reports
https://sentinels.copernicus.eu/web/sentinel/technical-guides/sentinel-3-olci/data-quality-reports
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3 SENTINEL-3 AND OLCI 
 
 
The Sentinel-3 missions are low-earth polar-orbiting satellites, operating at an average altitude 
of 815 km above the Earth’s surface with a repeat cycle of 27 days. Sentinel-3A and Sentinel-
3B have the same orbital parameters, but the latter is positioned 140o earlier in its orbit. 
Consequently, the ground tracks of the two satellites are "interleaved", giving a more complete 
and even sampling of the Earth’s surface, so as to better fulfil the monitoring role of the Sentinel 
missions. They each carry three instrument packages focusing on high-accuracy optical, 
thermal and altimetry data for marine and land services: 
 

• Optical: OLCI for medium resolution marine and terrestrial optical measurements,  
• Thermal: Sea and Land Surface Temperature Radiometer (SLSTR) for marine and 

terrestrial thermal measurements,  
• Altimetry: SAR Radar Altimeter (SRAL) together with the MicroWave Radiometer 

(MWR) and Precise Orbit Determination (POD) for surface topography measurements. 
 
It is the first of these, OLCI, which is the subject of this handbook, within a marine context.  

3.1 Ocean colour: a brief historical background 
The satellite ocean colour era began in the late 1970’s with the Coastal Zone Colour Scanner 
(CZCS). Though experimental, this sensor provided vastly more data than expected and 
showed the potential of satellite data for observing and understanding the dynamics of marine 
ecosystems at a global scale.  More than ten years passed before new sensors were launched, 
and the continuous ocean colour record began. The Japanese Ocean Colour and Temperature 
Sensor (OCTS) preceded long data records from the Sea-viewing Wide Field-of-view sensor 
(SeaWiFS), launched in 1997 on board the NASA SeaStar satellite, soon followed by the 
Moderate-resolution Imaging Spectroradiometer (MODIS) on board the Terra and Aqua 
satellites, launched in 1999 and 2002 respectively, and then in 2002 the MEdium Resolution 
Imaging Spectrometer (MERIS), onboard the European Space Agency (ESA) Envisat satellite. 
The overlap between these missions has been crucial for developing an understanding of how 
sensor design affects applications, and has facilitated the development of ocean colour data as 
a time series for climate scale studies. Further sensors were also launched, including the first 
geostationary sensor (Geostationary Ocean Color Imager (GOCI) from Korea), and the Indian 
Ocean Colour Monitor (OCM-2) onboard ISRO's Oceansat-2 satellite. Each sensor has offered 
different advantages in terms of spatial, temporal, and spectral resolution, as well as signal to 
noise ratios. 

The next generation of ocean colour satellites is now being launched, with lessons learned from 
previous missions improving both sensor design and programme contingency. The NOAA 
VIIRS sensors and NASA-planned hyperspectral PACE mission, provide a follow-on to 
NASA’s historical ocean colour sensors. Whilst in Europe, the legacy of MERIS formed the 
basis for the OLCI sensor, on board Sentinel 3A and 3B, as part of the Copernicus programme. 
OLCI has more spectral bands than MERIS, enhancing both the ability to atmospherically 
correct the data, as well as to extract a wider range of information about optically significant 
constituents in ocean waters. OLCI also provides global coverage at 300 m, a further 
advancement from the MERIS era, when 300 m data saw a huge growth in the use of ocean 
colour data for coastal and inland applications.  A further strength of the Copernicus 
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programme is the planned continuity with Sentinel 3A and Sentinel 3B currently in operational 
phase, and with Sentinel-3C and 3D planned, this will not only provide more regular imagery 
than from a single sensor, but also redundancy, ensuring the ocean colour record continues into 
the future. 

3.2 Complementarities with other ocean colour missions 
Sentinel-3 OLCI opens an era of European operational ocean colour observations and 
represents a significant achievement in the maturity, accessibility, continuity and routine 
utilization of ocean colour measurements, together with the United States’ Visible Infrared 
Imaging Radiometer Suite (VIIRS). 
 
All these missions, from CZCS to OLCI, tend to follow a set of recommendations provided by 
the International Ocean-Colour Coordinating Group (IOCCG) [RD-6]. IOCCG also provides a 
more complete list of missions2, allowing for near-continuous global observations of water 
radiometry and Chl. OLCI is based on its MERIS heritage, in terms of both the sensor design 
and algorithms that have been used for generating the products. 
 

                                                   
2 IOCCG list of missions and instruments: http://ioccg.org/resources/missions-instruments/   

http://ioccg.org/resources/missions-instruments/
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4 OLCI: GEOPHYSICAL VARIABLES, INSTRUMENTS AND PRINCIPLE 

4.1 Ocean colour coverage of all aquatic environments 

Throughout this document, we refer to ‘ocean colour’. However, the reader should be aware 
that OLCI provides products over all aquatic environments: the open ocean, seas, coastal zones 
and inland waters. Unless information is specified as only relevant to a given domain (e.g. open 
ocean only), then it should be considered as relevant to all. 

4.2 Instrument coverage 
The Sentinel-3 satellites are in a sun-synchronous orbit, completing 385 orbits (i.e. 770 pole-
to-pole tracks) in exactly 27 days. Sentinel-3B orbits 140o out of phase in advance of Sentinel-
3A to give a denser pattern of coverage. The mean global coverage revisit time for OLCI 
observations is 1.9 days at the equator (one operational spacecraft) or 0.9 days (two satellites 
in constellation) with these values increasing at higher latitudes, due to orbital convergence. 
Due to changes in available light with season, OLCI’s coverage is periodically limited at high 
latitudes, as shown in Figure 1 and Figure 2. 

 

Figure 1: The average OLCI revisit time for two satellites during the boreal winter period, the 27-day cycle 
centred on December 21st. Coverage has been masked for high glint, and zones where high solar zenith angle 
are indicated. Note that, in boreal mid-winter, OLCI does not acquire data poleward of ~60°N due to prevailing 
darkness at the overpass time. 
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Figure 2: As in Figure 1, but for boreal summer, the 27-day cycle centred on June 21st. Note that, due to the 
orbital inclination of the Sentinel-3 satellites the winter and summer coverage maps are not symmetrical. 

 

4.3 Ocean colour measurement principles  
Ocean colour is the change in the colour of the ocean, and other water bodies such as seas and 
lakes, due to the substances dissolved and particles suspended within the water. In the middle 
of the open ocean the water tends to be blue in colour. Close to the coast, the water varies in 
colour from blue to green, to brown and to white depending on what is present in it. By 
numerically quantifying this change in colour, concentrations of in-water constituents can be 
determined. Of major interest are phytoplankton, the microscopic algal plants in the ocean, as 
well as suspended sediments and coloured dissolved organic matter. 
 
Space sensors retrieve the spectral distribution of upwelling radiance just above the sea surface, 
which is termed the water-leaving radiance (Lw). From the water-leaving radiance, 
concentrations of in-water constituents and their inherent optical properties are derived. 
However, the sensors actually measure the Top Of Atmosphere (TOA) radiance and so the 
contribution resulting from the atmosphere’s scattering and absorption needs to be accounted 
for through Atmospheric Correction (AC).  
 
Atmospheric correction for ocean colour data is challenging [RD-1] as only about 10% of the 
radiance measured by a satellite instrument in visible blue and green wavelengths originates 
from the water and significantly less in the red. The sensors thus require very low radiometric 
and spectral uncertainties and a high signal to noise ratio (SNR), particularly for the ‘blue’ 
bands (~ 400 nm). Ocean colour instrument design must therefore incorporate extremely 
sensitive and stable radiometry, dedicated on-board calibration and spectral bands located at 
wavelengths of specific interest, not only to quantify suspended phytoplankton and other 
particles and substances in the water, but also to quantify the atmospheric constituents in order 
to better correct for the atmospheric effects. 
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Once corrected, the water-leaving radiance is normalized, 𝐿𝐿𝑤𝑤𝑤𝑤, to approximate the Sun at 
zenith, absence of the atmosphere, and a mean Sun-Earth distance (Morel and Gentili, 1996 
[RD-2]): 

𝐿𝐿𝑤𝑤𝑤𝑤(𝜆𝜆𝑖𝑖) = 𝐿𝐿𝑤𝑤(𝜆𝜆𝑖𝑖)
𝑡𝑡𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑(𝜆𝜆𝑖𝑖)𝜇𝜇𝑠𝑠𝐶𝐶𝑠𝑠

        (Eq. 1) 
 
where 𝑡𝑡𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑 is the total (i.e. direct plus diffuse, Rayleigh plus aerosol) downward transmittance 
of the atmosphere, 𝜇𝜇𝑠𝑠 -the cosine of the solar zenith angle, and 𝐶𝐶𝑠𝑠 -a coefficient accounting for 
the variation in the Sun-Earth distance. Conversion to remote-sensing reflectance and water 
reflectance is expressed in Eqs 2 and 3, where 𝐹𝐹0 is the mean extraterrestrial solar spectral 
irradiance. Water reflectance is also sometimes called water-leaving reflectance. The name 
‘water reflectance’ will be used in the rest of this document.  
 

𝑅𝑅𝑟𝑟𝑟𝑟(𝜆𝜆𝑖𝑖) = 𝐿𝐿𝑤𝑤𝑤𝑤(𝜆𝜆𝑖𝑖)
𝐹𝐹0(𝜆𝜆𝑖𝑖)

          (Eq. 2) 
 

𝜌𝜌𝑤𝑤(𝜆𝜆𝑖𝑖) = 𝜋𝜋𝐿𝐿𝑤𝑤(𝜆𝜆𝑖𝑖)
𝐹𝐹0(𝜆𝜆𝑖𝑖)

   or    𝜌𝜌𝑤𝑤(𝜆𝜆𝑖𝑖) = 𝜋𝜋𝐿𝐿𝑤𝑤(𝜆𝜆𝑖𝑖)
𝑡𝑡𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑(𝜆𝜆𝑖𝑖)𝐹𝐹0(𝜆𝜆𝑖𝑖)𝜇𝜇𝑠𝑠𝐶𝐶𝑠𝑠

      (Eq. 3) 
 
Note that both reflectances in Eq. 2 and 3 are not corrected for the Bidirectional Reflectance 
Distribution Function (BRDF) (Morel et al., 2002 [RD-3]). These are directional reflectances 
and are still dependent on their viewing direction, i.e. on the angular distribution of the 
upwelling underwater radiance and on the transmittance through the sea surface from water to 
air. Radiance or reflectance products from various missions are often corrected for the BRDF. 
OLCI standard product is the directional water reflectance from Eq. 3, i.e. OLCI water 
reflectance product is not corrected for the BRDF effect.  
 
These radiometric products are then used to estimate geophysical parameters through the 
application of specific bio-optical algorithms e.g. estimates of phytoplankton biomass through 
determining the Chlorophyll-a (Chl) concentration. The Ocean Colour for MERIS (OC4Me) 
Chl algorithm uses the irradiance reflectance (R) as the input [RD-4]: 
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       (Eq. 6) 

where Eq. 6 applies the BRDF correction with the Q factor being Chl-dependant, and ℜ is a 
geometrical factor that encompasses the air-sea interface effects [RD-2]. OC4Me algorithm is 
applied for OLCI for chlorophyll levels higher than 0.1 mg/m3.  
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Chl is more difficult to quantify in complex waters, as opposed to open waters, due to a more 
complex bio-optical signal. Clear waters in the open ocean, seas and some lakes have the 
spectral signature dominated by phytoplankton pigments. On the other hand, complex waters 
are significantly influenced by Coloured Dissolved Organic Matter (CDOM) [RD-5] and/or 
suspended sediments (Total Suspended Matter, TSM) and phytoplankton and primarily occur 
in coastal and inland zones. Therefore, OLCI has separate Open Water and Complex Water 
approaches for deriving its ocean colour products. Open and Complex water classification has 
been also called Case 1 and Case 2 water, respectively. [Table 4 in section 6.5  explains which 
approaches are used to derive individual OLCI standard products, e.g. OC4Me chlorophyll-a 
is developed for Open Waters and a neural network based approach (NN) for Complex Waters.] 

4.4 OLCI instrument specifics  
The key mission driver for the Sentinel-3 OLCI instrument is continuity of the Envisat MERIS 
instrument capability [RD-7]. As such, it is a push-broom imaging spectrometer with 5 camera 
modules sharing the Field Of View (FOV): 

• The five cameras’ FOV are arranged in a fan-shaped configuration in the vertical plane 
perpendicular to the platform velocity, 

• Each camera has an individual FOV of 14.2 degrees with a 0.6 degree overlap with its 
neighbours, 

• Each camera is equipped with a CCD composed of 740 x 520 detectors, where 740 pixels 
correspond to the spatial extent of the camera FOV and 520 pixels to the decomposition of 
radiance into spectral components from 390 nm to 1040 nm, 

• Five camera FOV is tilted westwards across-track by 12.58 degrees away from the Sun to 
minimise the Sun glint impact. 

OLCI has the following significant improvements when compared to MERIS: 

• An increase in the number of spectral bands (from 15 to 21), 
• Improved SNR and a 14-bit analogue to digital converter (ADC), 
• Improved coverage of global aquatic environments when there are 2 satellites (A & B): ~ 

3 days ignoring the effect of clouds. 
• A long time-series dataset, made by launching 4 missions (A to D) over 20+ years. 
• Improved data delivery timeliness for L1B and L2 products, for NRT products being 3 

hours from the time of sensing, 
• 100% overlap with SLSTR swath, and simultaneous acquisitions facilitating the use of 

OLCI and SLSTR in synergy. 
 
The 21 wavelengths used to measure TOA radiance are as shown Table 1, alongside the SNR 
for a reference radiance (Lref) that approximates the expected signal from an open-ocean water 
pixel; see [RD-7] for the reference radiance values. The measured spectral response functions, 
which described the true shape of the wavebands, are available for both Sentinel 3A and 3B. 
These can be accessed via the link in the footnote of this page3. 
 
The sampling period of the OLCI detectors (CCD’s) runs at 44 ms, which correspond to a mean 
along-track distance of about 300 m. Therefore, OLCI produces the Full Resolution (FR) 
                                                   
3 Link to the OLCI-A and OLCI-B Spectral Response Functions Document: 
https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-olci/olci-instrument/spectral-response-function-
data 

https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-olci/olci-instrument/spectral-response-function-data
https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-olci/olci-instrument/spectral-response-function-data
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product with a spatial resolution of approximately 300 m. In addition, the Reduced Resolution 
(RR) product is generated with a spatial resolution of approximately 1.2 km with 16 (nominally 
four by four) FR pixels averaged to create a RR pixel; the number of pixels used is varied in 
the across track direction, as a function of the across track pointing angle from the RR product 
pixel centre, so that spatial resolution degradation is minimised at the FOV edges. 

4.5 Calibration and validation activities 
Sentinel-3 calibration and validation (Cal/Val) activities are essential to the quality of the 
mission. Calibration determines the quantitative response of a system or measuring instrument, 
to known and controlled inputs. The calibration of satellite instrument allows it to provide 
reliable data to meet the mission requirements (AD-2) and the requirements of applications and 
services. 
 
In terms of the onboard calibration, OLCI is equipped with a calibration assembly, which 
includes a motorized wheel with three fixed diffusers, a shutter, and an Earth View port that 
allows the cameras free access to the Earth in imaging mode. Calibrations happen periodically, 
mostly at the ecliptic South Pole where the sunlight can reach the exposed diffuser in the 
calibration assembly [RD-15]. There are 3 Sun diffusers: 2 “white” diffusers dedicated to 
radiometric calibration, and one doped with erbium dedicated to spectral calibration [RD-15]. 
 
In addition to instrument pre-launch and onboard calibrations, a System Vicarious Calibration 
(SVC) must be applied to achieve the required ocean colour product uncertainties ([AD-2]; 
[RD-6]; [RD-16]). 
 
SVC uses highly accurate in situ measurements of water-leaving radiances, which are the best 
quality radiometric Fiducial Reference Measurements for ocean colour. SVC employs these 
FRMs to reduce residual biases in Level-2 products. Details of the SVC process can be found 
in [RD-17].  
 
Validation is focused on independently assessing the accuracy and stability of the satellite 
products. For ocean colour this involves inter-comparisons with high-quality ground-truth in 
situ measurements (FRMs) of both the radiometry and bio-optical parameters and inter-
comparisons with corresponding products from other stable missions and climatologies. In 
ocean colour, in situ FRMs provide critical knowledge of the ground truth but are sparse due 
to the complexity of radiometric and bio-optical measurements from ships and instrumented 
platforms. Mission inter-comparisons allow for large-scale global time-series evaluations. 
 
To support validation, EUMETSAT and ESA have a permanently-open Announcement of 
Opportunity call4 "To engage world-class validation expertise and activities to complement 
Sentinel-3 routine validation activities and ensure the best possible outcomes for the Sentinel-
3 Mission". Sentinel-3 Validation Team (S3VT) supports Agency product validation efforts 
and receives privileged access to the Sentinel-3 OLCI data. 
 
 
 

                                                   
4S3VT main web page: https://nikal.eventsair.com/QuickEventWebsitePortal/sentinel-3-validation-team-
s3vt/esa 
 

https://nikal.eventsair.com/QuickEventWebsitePortal/sentinel-3-validation-team-s3vt/esa
https://nikal.eventsair.com/QuickEventWebsitePortal/sentinel-3-validation-team-s3vt/esa
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Table 1: OLCI wavebands; updated from [RD-7] 

Band 
number 

Central 
wavelength 

[nm] 

Spectral 
width 
[nm] 

SNR @ Lref for each of the 5 
cameras* 

Function 

Oa1 400.000 15 2420/2396/2324/2369/2278 AC, improved water 
constituent retrieval 

Oa2 412.500 10 2398/2410/2341/2402/2387 CDOM and detrital pigments  

Oa3 442.500 10 2161/2200/2167/2186/2198 Chlorophyll-a  (Chl-a) 
absorption maximum 

Oa4 490.000 10 2000/2035/1995/1982/1987 High Chll-a and other 
photosynthetic pigments 

Oa5 510.000 10 1979/2013/1982/1965/1984 Chl-a, TSM, turbidity and red 
tides 

Oa6 560.000 10 1776/1802/1801/1794/1818 Chl-a reference (minimum) 

Oa7 620.000 10 1591/1610/1625/1593/1615 TSM 

Oa8 665.000 10 1547/1559/1566/1533/1560 Chl-a (2nd absorption 
maximum), TSM and CDOM 

Oa9 673.750 7.5 1329/1338/1350/1324/1341 Improved fluorescence 
retrieval  

Oa10 681.250 7.5 1320/1327/1338/1314/1332 Chl-a fluorescence peak 

Oa11 708.750 10 1420/1421/1434/1413/1429 Chl-a fluorescence baseline 

Oa12 753.750 7.5 1127/1120/1133/1124/1138 O2 (oxygen) absorption and 
clouds 

Oa13 761.250 2.5 502/498/505/500/507 O2 absorption band and AC 
aerosol estimation 

Oa14 764.375 3.75 663/658/667/661/669 AC 

Oa15 767.500 2.5 558/554/562/556/564 O2 A-band absorption band 
used for cloud top pressure 

Oa16 778.750 15 1514/1496/1523/1509/1524 AC aerosol estimation 

Oa17 865.000 20 1243/1213/1238/1245/1250 AC aerosol estimation, 
clouds and pixel co-
registration, in common with 
SLSTR 

Oa18 885.000 10 823/801/814/824/831 Water vapour absorption 
reference band 

Oa19 900.000 10 691/674/683/693/698 Water vapour absorption 

Oa20 940.000 20 535/523/525/539/542 Water vapour absorption, 
linked to AC 

Oa21 1020.000 40 346/338/349/346/351 AC aerosol estimation 

                                                   
* Data supplied by Donlon (pers. comm.), correct as of June 2017 for Sentinel-3A 
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4.6 Where to go for further information on the algorithms 
The detail of each algorithm is written within an Algorithm Theoretical Basis Document 
(ATBD), which is publicly accessible5. A list of the ATBD documents is provided in Table 2. 

Table 2: OLCI ocean colour product primarily ATBDs  

Product ATBD ATBD Reference 

Oa##_reflectance, 
A865 & T865 

Baseline AC: Atmospheric correction over 
Open Waters with integrated OLCI Bright 
Pixel Correction (BPC) 

S3-L2-SD-03-C07-LOV-ATBD & 
EUM/OPS-
SEN3/DOC/17/961973(MERIS 
ATBD 2)  

PAR Instantaneous Photosynthetically Active 
Radiation 

S3-L2-SD-03-C12-ARG-ATBD 

CHL_OC4ME & 
KD490_M07 

Ocean Colour Products in Open Water S3-L2-SD-03- C10-LOV-ATBD 

ADG443_NN, 
CHL_NN & 
TSM_NN  

Alternative AC: Atmospheric correction over 
Complex Waters, based on Neural Network 
regression 

S3-L2-SD-03-C17-GKSS-ATBD 

Ocean Colour Complex Water S3-L2-SD-03-C11-GKSS-ATBD 

IWV Integrated Water Vapour column Lindstrot et al., 2012 [RD-14] 

                                                   
5 EUMETSAT’s ocean colour webpage: https://www.eumetsat.int/ocean-colour-services, 
https://www.eumetsat.int/ocean-colour-resources   

https://www.eumetsat.int/ocean-colour-services
https://www.eumetsat.int/ocean-colour-resources
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5 PROCESSING LEVELS AND SCHEMES 
 
The OLCI operational processor comprises three major processing levels: 
 

• Level 0 
This step processes raw data contained in instrument source packets. Level 0 products 
are internal products, and are not disseminated to users. 
 

• Level 1 
This step processes the Level 0 data to geo-located and calibrated top of atmosphere 
radiances for each OLCI band. 
 

• Level 2 
This step processes the Level 1 data to water leaving reflectances and bio-optical 
variables (e.g. chlorophyll).  

5.1 Level-1 processing approach 
The OLCI L1B processor has 3 modes, each of which produce their own L1B products. The 
radiometric and spectral calibration modes process OLCI calibration data which are used off-
line to develop instrument radiometric and spectral models that are stored in dedicated look up 
tables. The Earth observation mode produces L1B calibrated and geolocated products at the 
full and reduced spatial resolution. The main data processing steps taken to produce Earth 
observation L1B products [RD-20] are: 
• Data extraction and quality checks 
• Radiometric Calibration 

o Primary instrument corrections and radiometric scaling 
o Stray light correction 

• Geo-referencing 
• Pixel classification 
• Spatial re-sampling 
• Annotations 
• Products formatting 
 
The OLCI Radiometric Model is based on the continuous set of in-flight radiometric 
calibrations. It includes radiometric gain coefficients at a reference date and a long-term 
evolution model. From 05/07/2017 and 29/10/19 onwards for OLCI-A and OLCI-B, 
respectively, and for reprocessed data, the set of radiometric gain coefficients used to derive 
both the Reference Gains and the Evolution Model have been computed using up-to-date 
geometric and spectral calibrations and instrument settings and the upgraded diffuser BRDF 
model based on in-flight data as well as diffuser ageing (browning) correction. The 
Radiometric Model is continuously monitored against new Radiometric Calibration 
acquisitions and updated calibration is used in the processing. More details can be found in the 
OLCI product notices6. 

                                                   
6 https://www.eumetsat.int/ocean-colour-services  
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5.2 Level-2 processing approach 
OLCI L2 processing flow is illustrated in Figure 1. Auxiliary data and parametrization of the 
processor are available in Auxiliary Data Files (ADFs) [RD-32].  
 
Level-2 pre-processing includes pixel classification, gaseous correction, computation of the 
Integrated Water Vapour product (IWV), alongside the smile correction, adjustments for white 
caps and sun glint, and application of System Vicarious Calibration gains. Then, the default 
operation is that two atmospheric correction (AC) approaches are run in parallel: the Baseline 
Atmospheric Correction (BAC) and the Alternative Atmospheric Correction (AAC). The BAC 
feeds the majority of further ocean colour steps and products, denoted here as Open Water 
products. The AAC feeds the NN Case 2 Regional / Coast Colour (C2RCC) processing and 
outputs three Complex Water products. 
 
The Baseline AC (BAC) algorithm is based on the algorithm developed for MERIS (Antoine 
and Morel, 1999 [RD-8]), to ensure consistency between the two instruments' records. BAC 
was designed for Open Waters, with a spectral signature dominated by phytoplankton 
pigments. The Bright Pixel Correction (BPC) integrated with BAC allows adaptation of the 
processing to more complex waters (Moore et. al. 1999 [RD-9] and Moore et al., 2017 [RD-
10]). The BPC accounts for situations where the Near Infrared (NIR) water-leaving radiance is 
not negligible i.e., high scattering waters where there is a high Chl and/or TSM concentration. 
The version implemented in the OLCI processing chain is an update of the Moore et. al. 1999 
[RD-9] paper, with improvements to the OLCI ATBD [RD-10] resulting from the 4th 
reprocessing of the MERIS data. Further improvements have been made as part of the 
OL_L2M.003 collection (see [RD-24] and references within). The OLCI algorithm uses a 
coupled atmosphere-hydrological model where the water contribution is implemented in terms 
of Inherent Optical Properties (IOPs). The model is solved using spectral optimization 
inversion at six  NIR bands. 
 
The output of the BAC processing is the water reflectance (see Eq. 3) alongside the aerosol 
optical depth (T865) and Ångström exponent (A865) that are calculated as part of the BAC 
process, and indicate the AC’s success in subtracting the atmospheric contribution. If the BAC 
is working correctly then the atmospheric by-products should not show contamination from 
marine features. 
 
The Photosynthetically Active Radiation (PAR) product, inherited from MERIS, is the 
instantaneous PAR at the water surface. It was originally developed for Sun-stimulated 
fluorescence calculations (Aiken and Moore, 1997 [RD-11]).  
 
The following bio-optical products, primarily applicable in Open Waters, are then calculated 
from water reflectance: 
 
Algal pigment concentration based on the Ocean Colour for MERIS (OC4Me) algorithm 
developed by Morel et al. (2007 [RD-12]), following the approach of O'Reilly et al. (1998 [RD-
22]), with the product called CHL_OC4ME. To complement the OC4Me algorithm, a 
chlorophyll index (CI) approach was developed for Collection OL_L2M.003 for application 
specifically in low-chlorophyll oligotrophic waters [RD-25]. The CI implementation is in 
response to S3 OLCI/SYN QWG and S3VT-OC recommendations. The CI methodology 
follows Hu et al. (2012) [RD-26], and the switching between CI and OC4Me (i.e. low and 
higher chlorophyll concentrations) follows Wang and Son (2016) [RD-27]. The CI algorithm 
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equation was parametrised for OLCI bands at 442.5, 560, and 665 nm, which are different from 
the original SeaWiFS bands used in the paper by Hu et al. (2012) [RD-26]. The parametrization 
applied in situ HPLC measurements of chlorophyll concentrations in the range below 0.16 
mg/m3 and simultaneous in situ Rrs measurements in the three aforementioned OLCI bands, 
from NASA’s SeaBASS database [RD-28]. The switching between CI and OC4Me algorithms, 
based on Wang and Son (2016) [RD-27] Rrs ratio approach, 442.5/560 nm, uses the thresholds 
and the algorithm mixing span adapted to OLCI bands and to the chlorophyll range from the 
CI parametrization. Collection OL_L2M.003 keeps the historical name of OC4Me Algal 
Pigment Concentration product but implements CI and OC4Me algorithms. The details of 
OLCI CI algorithm implementation and its validation results are described in EUMETSAT 
document (RD-25). The original OC4Me algorithm used in the previous OLCI processing 
versions systematically underestimated the low range of chlorophyll concentrations, as 
documented by S3 OLCI/SYN QWG and S3VT-OC. 

 
• Diffuse Attenuation coefficient at 490 nm (KD490_M07), as outlined in [RD-12]. 
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Figure 3: L1 to L2 processing. 

 
 
The output of the AAC processing is water reflectance, which is an internal processor product. 
AAC is based on an artificial neural network (NN), considering the correction over complex 
waters with significant CDOM and/or TSM contributions. The TOA reflectances in 15 bands 
(400-753 nm, 778, 865 and 1020 nm), corrected for absorbing gases and the smile effect (see 
Section 8.1.1), are used together with wind speed, salinity, temperature, altitude of the water 
surface and observation geometry to estimate the water reflectances and atmospheric 
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parameters. These reflectances and atmospheric parameters are not included within the 
standard products. The second NN retrieves Inherent Optical Properties from the internal water 
reflectance, including total backscattering coefficient bbp, phytoplankton absorption coefficient 
apig, and coloured Detrital and Dissolved Material absorption coefficient adetritus + ag, all at 442.5 
nm. This alternative processing chain was originally developed for MERIS (Doerffer and 
Schiller, 2007 [RD-13]), and was updated following several ESA funded projects to become 
the C2RCC processor. A further update was made to the NNs with collection OL_L2M_003 
[RD-24] (NNv2). The three OLCI NN operational products (i.e. CHL_NN, ADG443_NN, and 
TSM_NN) are derived from IOPs outputted by the second IOP NN.   Then, the following 
products are generated: 
 
• ADG443 [m-1] as the product ADG443_NN 
• Algal pigment concentration [mg.m-3] as the product CHL_NN, calculated as in Eq. 7 

 
𝐶𝐶𝐶𝐶𝐶𝐶_𝑁𝑁𝑁𝑁 = 21 𝐴𝐴𝐴𝐴𝐴𝐴442.51.04        (Eq. 7) 

 
• TSM [g.m-3] as the product TSM_NN, calculated as in Eq. 8 

 
𝑇𝑇𝑇𝑇𝑀𝑀𝑁𝑁𝑁𝑁 = 1.06 𝐵𝐵𝐵𝐵𝐵𝐵442.5^0.942      (Eq. 8) 

 
 

The NNv2 processor produces similar results to the C2RCC processor as available in SNAP. 
However some differences are the result of pixel classification, gaseous correction, smile 
correction, and most significantly, SVC gains, all of which are applied in the operational 
processor but not automatically included in the SNAP processing (see [RD-24] for SVC 
details). 
 
 



EUM/OPS-SEN3/MAN/17/907205 
v2G e-signed, 12 March 2021 

Sentinel-3 OLCI Marine User Handbook 
 

This Document is Public 

Page 29 of 48 

 

6 OLCI PRODUCTS AND FILE TYPES 
There are two OLCI marine product types that are disseminated to users. These are provided 
at two resolutions, full (FR) and reduced (RR). 
 

• Level 1B EFR/ERR 
The Level-1B product provides calibrated upwelling radiances at TOA for each pixel, 
each view and each OLCI band, plus annotation data associated to OLCI pixels. 

 
• Level 2 WFR/WRR  
The Level-2 water product provides water and atmospheric geophysical parameters. 

For the nominal orbit, at sub-satellite point, OLCI Full Resolution is approximately 300 m on 
ground. For the nominal orbit, at sub-satellite point, OLCI Reduced Resolution is 
approximately 1.2 km on ground. 
 
OLCI Level-1B EFR/ERR and Level-2 WFR/WRR data products are freely available to the 
public. OLCI files are collected into a SAFE container containing free-standing NetCDF-4 
format files. 

6.1 Product timeliness 
OLCI data are provided as Near Real-Time (NRT) and Non-Time Critical (NTC) products, 
with the NTC products being constrained by the timeliness of the input ancillary meteorological 
information. NRT products use ECMWF meteo forecast data and NTC products use ECMWF 
analysis data. At Level 1B, the difference between OLCI NRT and NTC products is in the 
ancillary meteo values at tie points and in sun_glint_risk flag that uses the ECMWF wind speed. 
There is no difference in the radiance products between NRT and NTC at Level 1B. 
 
OLCI product timeliness: 
NRT – 3 hour timeliness from the time of data sensing 
NTC – up to 1 month timeliness from the time of data sensing 

6.2 File naming  
The file naming is based on a sequence of fields [RD-19]:  

 
MMM_SS_L_TTTTTT_YYYYMMDDTHHMMSS_YYYYMMDDTHHMMS
S_YYYYMMDDTHHMMSS_<instance ID>_GGG_<class ID>.<extension> 

 
Which for Sentinel-3 OLCI marine data would be, for example: 
 

S3A_OL_1_EFR____20160509T103945_20160509T104245_20160509T124907
_0180_004_051_1979_MAR_O_NR_001.SEN3 

 
• MMM – Mission id, e.g. S3A 
• SS - Data source/consumer, e.g. OL is for OLCI 
• L - Processing level, e.g. 1 for L1 and 2 for L2 
• TTTTTT - Data Type ID, e.g.  

o “EFR___” = L1B product at FR 
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o “ERR___” = L1B product at RR 
o “WFR___” = L2 FR water (marine) product 
o “WRR___” = L2 RR water (marine) product 

• YYYYMMDDTHHMMSS - 15 character date and time (date plus “T” plus time) for (1) Data 
Start (2) Data Stop time, and (3) Creation Date 

• <instance id > - 17 characters e.g. 0180_004_051_1979 is duration (sensing time interval in 
seconds), cycle number, relative orbit number, and frame along track coordinate (elapsed time in 
seconds from the ascending node indicating the frame start time) 

• GGG – Product Generating Centre e.g., MAR = MARINE (EUMETSAT)  
• <class ID> - 8 characters to indicate the processing system e.g., O_NR_001 is (1) the software 

platform (O for operational, F for reference, D for development and R for reprocessing), (2) the 
processing workflow (NR for NRT, ST for STC and NT for NTC) and (3) 3 letters/digits 
indicating the baseline collection. 

• <extension> - Filename extension, SEN3 

6.3 Data format 
The data format is a Standard Archive Format for Europe (SAFE) product package containing 
a collection of files, see Figure 4. The manifest file (xfdumanifest.xml) explains the contents 
of the package at an overarching level. Each of the measurement and annotation data files are 
stored in netCDF (version 4) format, with the filenames given in Section 6.4 and 6.5. The 
product package can exist as a directory in a filesystem, zipped folder or tarball. 
 
OLCI products are disseminated in Product Dissemination Units (PDUs). OLCI RR PDUs are 
provided as whole daylight orbits, while the FR PDUs are provided as 3-minute granules as it 
is much larger in file size than the RR data. 
 
 

 

Figure 4: OLCI file format 

6.4 Level 1 product contents 
The L1B products are TOA (upwelling) radiances [mW.m-2.sr-1.nm-1], calibrated to 
geophysical units and ortho-geolocated onto the Earth's surface. They are spatially resampled 
onto an evenly spaced cross-track grid, FR or RR, based on the computed pointing angle and 
according to the surface of the reference ellipsoid. Product pixels are filled with nearest 
neighbour instrument pixels for FR products, and nearest neighbour averages of the 
surrounding instrument pixels for RR products. The products are then annotated with the 
illumination and observation geometry, environment data (meteorological data) plus quality 
and classification flags. 
 
The measurement netCDF data files include [RD-21]: 

L1 & L2 product packages contain:

manifest file 
(xfdumanifest.xml)

netCDF measurement 
and annotation data files
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• “OL_1_ERR___” contains: 

o Oa##_radiance.nc - 21 measurement data files (one per band) containing the TOA 
radiances at each band, accompanied by the associated error estimates e.g., 
Oa01_radiance.nc for the band 1 OLCI radiance data.  

• “OL_1_EFR___” contains the: 
o Oa##_radiance.nc - the same 21 measurement data files as “OL_1_ERR___”,  
o removed_pixels.nc - providing all data related to pixels that have been removed 

during the re-sampling process. 

Note: The accompanied product uncertainty estimates Oa##_radiance_err are currently not 
present in OLCI L1B products. 
 
The annotation netCDF data files [RD-21] include: 
 
• time_coordinates.nc - time_stamp of the each frame of the product  
• geo_coordinates.nc - longitude, latitude and altitude   
• qualityFlags.nc - quality_flags, as specified in Table 3. 

Table 3: L1 Quality flags  

Flag Description 

land land as the underlying surface, whatever the atmosphere conditions 
i.e., whether cloudy or not 

coastline coastline pixels 

fresh_inland_water pixels within inland water bodies, and so are also flagged as land 

tidal_region pixels enclosed in areas of high tidal activity 

bright any pixel with a TOA reflectance greater than a defined threshold 
[RD-20] is assumed to be cloud contaminated, thick aerosols or haze, 
bright land surfaces (such as sand, snow and ice) or bright water 
surfaces (such as sea ice or sun glint) 

straylight_risk identifies pixels for which an insufficient number of neighbours were 
available for a good correction of the Ground Imager straylight [RD-
7] 

invalid missing data due to a transmission error, resulting in missing packets, 
or due to out of swath or defects in the CCD cells [RD-20] 

cosmetic if missing data have been cosmetically filled, e.g. because the 
transmission error gap was between valid frames, i.e. lines [RD-20] 

duplicated duplicated pixel during cross-track ground pixel resampling 

sun_glint_risk Sun glint risk flag, estimated from the wind speed and Solar Zenith 
and Viewing Angles (SZA, VZA) [RD-20] 

dubious pixels within potential contamination by neighbouring saturated pixels 
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saturated_Oa01 to 
saturated_Oa21 

saturation at the ADC and sensor levels 

  

• Tie-point based data available at every 16th cross-track pixel along each row 
o tie_geo_coordinates.nc – longitude and latitude   
o tie_geometries.nc – solar and observation geometries - SZA, SAA, OZA and 

OAA   
o tie_meteo.nc – ECMWF modelled atmospheric_temperature_profile, 

horizontal_wind (vector at 10m altitude), humidity, reference_pressure_level, 
sea_level_pressure, total_columnar_water_vapour and total_ozone  

• instrument_data.nc - OLCI band central wavelengths and bandwidths (lambda0 and 
FWHM), equivalent in-band extraterrestrial solar irradiance corrected for the Sun-Earth 
distance (Solar Flux), instrument detector index representative of product pixel 
(detector_index), frame_offset and relative_spectral_covariance. 

6.5 Level 2 product contents  
The Level 2 products include the water- reflectance, atmospheric by-products and bio-optical 
products as shown in Table 4; see Section 5.2 for further details on the processing. 

Table 4: OLCI L2 water reflectance and bio-optical products and atmospheric by-products 

Product Name Units 
Products 

netCDF file  
Product name 

Description Application 

Water reflectances dimensionless 

Oa##_reflectance 
→ 

Oa##_reflectance 

 

where ## is the 
band number 

Primary output of the Baseline 
AC (BAC) processing, based 
on Antoine and Morel (1999 

[RD-8]) and Moore et. al. 
(2017 [RD-10]). In the viewing 

geometry and so not 
normalised for the bidirectional 

reflectance distribution 
function (BRDF). 

Ocean 
Colour 

 

Open Water 
Products 

Algal pigment 
concentration in 

open waters 
mg.m-3 chl_oc4me → 

CHL_OC4ME 

Ocean Colour for MERIS 
(OC4Me) developed by Morel 
et al. (2007 [RD-12]) and CI 

developed by Hu et al. 
(RD[25]). 

Diffuse attenuation 
coefficient at 490 

nm 
m-1 trsp → 

KD490_M07 
Developed by Morel et al. 

(2007 [RD-12]). 

Photosynthetically 
Active Radiation µEinstein.m-2 par → PAR 

Instantaneous PAR at the 
ocean surface (Aiken and 

Moore, 1997 [RD-11]). 

Aerosol Optical 
Thickness dimensionless w_aer →  T865 By-product of the BAC 

processing. 
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Product Name Units 
Products 

netCDF file  
Product name 

Description Application 

Ångström exponent dimensionless w_aer →  A865 By-product of the BAC 
processing. 

Algal pigment 
concentration in 
complex waters 

mg.m-3 chl_nn → 
CHL_NN 

Complex water products 
derived from water 

reflectances obtained from the 
Alternative AC (AAC) 

processing. AAC is a neural 
network (NN) AC for 

correction over complex 
waters.  The products are 
derived from a NN inverse 
radiative transfer model, 
originally developed for 
MERIS by Doerffer and 

Schiller (2007 [RD-13]), and 
updated to become the Case 

2 Regional / Coast Colour 
(C2RCC) processor. NNv2. 

Ocean 
Colour 

 

Complex 
Water 

Products 

Coloured Detrital 
and Dissolved 

Material absorption 
coefficient at 443 

nm 

m-1 iop_nn  → 
ADG443_NN 

Total suspended 
matter 

concentration 
g.m-3 tsm_nn → 

TSM_NN 

Integrated Water 
Vapour column kg.m-2 iwv → IWV 

Total columnar water vapour 
based on 1D-Var retrieval 
originally developed for 

MERIS by Lindstrot et al. ( 
2012 [RD-14]). 

Atmospheric 
Products 

 
The processing, dissemination and archiving of the near-real-time and offline marine products 
are carried out at the Sentinel-3 Marine Centre located in EUMETSAT [RD-18]. 
 
The marine L2 products include: 

• Water reflectance in 16 bands in files named Oa##_reflectance.nc (excludes Oa13, Oa14, 
Oa15, Oa19 and Oa20 which are dedicated to atmospheric gas absorption measurements) 

• Ocean colour products  
o CHL in chl_oc4me.nc and chl_nn.nc from Open and Complex Water approaches 
o ADG443 in iop_nn.nc 
o TSM in tsm_nn.nc 

• KD490 in trsp.nc 
• Atmospheric by-products 

o PAR in par.nc 
o T865 and A865 in w_aer.nc 
o IWV in iwv.nc 

Note: The accompanied product uncertainty estimates, e.g. Oa##_reflectance_err, are currently 
only recommended for qualitative analyses because they do not contain the full uncertainty 
budget from L1 and L2 processing chains. 
 
There are also annotation netCDF data files that include: 

• time_coordinates.nc - Timestamp   
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• geo_coordinates.nc - Longitude, latitude and altitude   
• wqsf.nc – Water quality and science flags, which include Classification and Quality Flags 

as given in Table 5 and Table 6, respectively 

 

Table 5: L2 Water quality flags  

Flag Description 

INVALID Invalid flag: instrument data missing or invalid 

WATER Water (marine) with clear sky conditions, i.e. no clouds 

CLOUD Cloudy pixel 

CLOUD_AMIBUOUS Possibly a cloudy pixel, the flag removes semi-transparent clouds 
and other ambiguous cloud signatures 

CLOUD_MARGIN Cloud edge pixel, the flag provides an a-priori margin on the ‘CLOUD 
or CLOUD_AMBIGUOUS’ flag of 2 pixels at RR and 4 pixels at FR 

COASTLINE Direct copy of the L1B coastline flag 

SNOW_ICE Possible sea-ice or snow contamination 

INLAND_WATER  Fresh inland waters flag (from L1B); these pixels will also be flagged 
as LAND rather than WATER 

TIDAL Pixel is in a tidal zone (from L1B) 

COSMETIC Cosmetic flag (from L1B) 

SUSPECT Suspect flag (from L1B) 

HISOLZEN High solar zenith: SZA > 70° 

SATURATED Saturation flag: saturated within any band from 400 to 754 nm or in 
bands 779, 865, 885 and 1020 nm 

MEGLINT Flag for pixels corrected for sun glint 

HIGHGLINT Flag for when the sun glint correction is not reliable 

WHITECAPS Flag for when the sea surface is rough and the whitecap correction is 
no more reliable at the wind speed above 12 m/s, see section 3.2.3 
of RD-24  

ADJAC Flag for adjacency effect indicating bright coastal pixels, see details 
in section 3.4.4.1 of RD-24  

TURBID_ATMOSPHERE Pixel’s diffuse path transmittance in band 865 nm (obtained from the 
NN AAC) is lower than a threshold (0.955), or pixel is saturated or 
excessively bright at 442.5 nm [RD-24] 

WV_FAIL IWV retrieval algorithm failed 
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AC_FAIL BAC atmospheric correction is suspect 

OC4ME_FAIL OC4Me algorithm failed 

OCNN_FAIL NN algorithm failed 

KDM_ FAIL  KD490 algorithm failed 

 

 
• Tie-point based data available at every 16th cross-track pixel along each row 

o tie_geo_coordinates.nc – longitude and latitude   
o tie_geometries.nc – solar and observation geometries - SZA, SAA, OZA and 

OAA   
o tie_meteo.nc – ECMWF modelled atmospheric_temperature_profile, 

horizontal_wind (vector at 10m altitude), humidity, reference_pressure_level, 
sea_level_pressure, total_columnar_water_vapour and total_ozone 

• instrument_data.nc 
o OLCI band central wavelengths and bandwidths (lambda0 and FWHM) 
o equivalent in-band extraterrestrial solar irradiance (Solar Flux) 
o instrument detector index representative of product pixel (detector_index) 
o frame_offset and relative_spectral_covariance 

Table 6: L2 Science flags  

Flag Description 

BPAC_ON Bright Pixel Correction converged and a NIR signal was determined 

WHITE_SCATT "White" scatterer within the water e.g. coccoliths 

LOWRW Water reflectance at 560 nm is less than a defined threshold or HIINLD_F 
raised (flag for low pressure water i.e., high altitude inland waters) 

HIGHRW High water reflectance at 560 nm or the TSM retrieved as part of the BPAC 
is above a threshold 

ANNOT Annotation flags for the quality of the atmospheric correction, including:  

• ANGSTROM (Ångström exponent cannot be computed); 

• AERO_B (blue aerosols);  

• ABSO_D (desert dust absorbing aerosols);  

• ACLIM (aerosol model does not match aerosol climatology);  

• ABSOA (absorbing aerosols);  

• MIXR1 (aerosol mixing ratio is equal to 0 or 1);  

• DROUT (value of residual surface reflectance for the selected aerosol 
model candidate pairs is above a certain threshold compared to 
climatology);  

• TAU06 (aerosol optical thickness is greater than a defined threshold) 



EUM/OPS-SEN3/MAN/17/907205 
v2G e-signed, 12 March 2021 

Sentinel-3 OLCI Marine User Handbook 
 

This Document is Public 

Page 36 of 48 

 

RWNEG_O01 to 
RWNEG_O21 

Provides a "negative water reflectance" flag for each band’s water 
reflectance: the value below which pixels are flagged varies according to 
the band, with the threshold stored in OL_2_ACP_AX ADF [RD-32] 

6.6 Product features and limitations 
In Level 2 products, inland waters have both the INLAND_WATER and LAND flags 
activated, but not the WATER flag. While marine waters have the WATER flag activated. 
 
The BPAC_ON flag indicates that the spectral optimization inversion in the BAC’s Bright 
Pixel Correction was activated, converged, and a NIR signal of water was determined.  
 
Product limitations are described in detail in Product Release Notices. Please refer to the 
Notices for the detailed status of the products (https://www.eumetsat.int/ocean-colour-
services). 
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7 HELPDESK, DATA ACCESS AND TOOLS 

7.1 Registration  

Registration for EUMETSAT data access is required and is available from 
https://eoportal.eumetsat.int/. The registration and data access are free, full and open. Beyond 
access to data, one may also register for the User Notification Service which provides 
information on product releases and warnings in case of space or ground segment anomalies. 
Members of S3VT may also request privileged access to certain datasets by contacting 
EUMETSAT Help Desk at ops@eumetsat.int. 

7.2 Helpdesk and Training 
The EUMETSAT User Helpdesk is available to all users during standard office hours. The 
service provides support on data access and product usage and application. All user requests 
on the EUMETSAT OLCI Marine data products should be directed to the EUMETSAT Help 
Desk at ops@eumetsat.int.  
 
Information on training, including sessions with a focus on the Copernicus Marine Data 
Stream, is available via https://www.eumetsat.int/data-and-user-support/training.  

7.3 Data Access Methods  
EUMETSAT provides data access through a number of routes, depending on your preferred 
delivery mode and the latency of the data that’s needed. The central catalogue in the first tier / 
row of Figure 5 and Table 7 lists all EUMETSAT missions (Meteosat, Metop, and Jason-2) in 
addition to the Copernicus Sentinel-3 marine and atmosphere products. 
  

 

Figure 5: Data access routes 
 
For those downloading data from the internet, there are at least 3 routes. If you are interested 
in just recently acquired data (up to 1 year) then the best access route is the Copernicus Online 

Access route

Access method

Starting point eoportal.eumetsat.int

Internet connection

Historical data 

Data Centre Long-Term 
Archive

Reprocessed Data 
(CODAREP)

Recently acquired data 
(last 12 months)

Copernicus Online Data 
Access (CODA)

Online Data Access 
(ODA) for S3VT 

members

Telecoms satellite link 
and terrestrial network

EUMETCast: 
subscription request

mailto:ops@eumetsat.int
https://www.eumetsat.int/data-and-user-support/training
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Data Access (CODA) that provides an interactive interface. Batch scripting is also possible. In 
order to discover CODA’s functionalities and example scripts to download Sentinel-3 data 
using CODA APIs, read the User Guide (after registering and logging-in to CODA): 
 
 https://coda.eumetsat.int/manual/CODA-user-manual.pdf  
 
 

Table 7: Data access locations 

 

EUMETCast 

eumetcast.com    

Multi service push dissemination system based on 
multicast technology, which is transported to the user via 
satellite (EUMETCast Satellite, with coverage over 
Europe, the Middle-East and Africa).  

 CODA 

coda.eumetsat.int 

codarep.eumetsat.int 

Download service offers all the recently acquired 
Sentinel-3 marine and atmospheric products through a 
rolling archive that (at a maximum) will span 12 months. 
Products from the last year are also available via the 
EUMETSAT Data Centre Long-Term Archive. 
 
Users should note that reprocessed ocean colour data is 
made available through the parallel codarep portal. 
 
Routine access is supported by API and a Python toolkit 
(https://gitlab.eumetsat.int/eumetlab/cross-cutting-
tools/sentinel-downloader)  

 

Data Centre Long-Term 
Archive 

archive.eumetsat.int 

Ordering application that enables users to browse and 
select products, from EUMETSAT’s long-term archive, 
including the Copernicus Sentinel-3 marine and 
atmospheric products. 

 

EUMETView 

eumetview.eumetsat.int 

A visualisation service that allows users to view 
EUMETSAT’s data and Copernicus Sentinel-3 marine 
data in an interactive way using an online map view. 

 

WEkEO 

wekeo.eu  

WEkEO is one of the Copernicus Data Information and 
Access Services (DIAS), and is coordinated by 
EUMETSAT, ECMWF and Mercator Ocean. It offers 
data access and hosted processing resources. 

 
Data older than one year, but not yet reprocessedcan be accessed from the EUMETSAT Data 
Centre. The Data Centre allows you to access either the global dataset (under the Products tab: 
enter OLCI as a search term so you see just these products) or regions of interest such as the 
North Atlantic and Mediterranean Sea (under the Sentinel 3 Datasets tab); see Figure 6. Then, 
on subsequent screens you can define a region of interest and time period before ordering the 
products. Selecting a given dataset or a region of interest will return all products that intercept 
that region. 
 

https://coda.eumetsat.int/manual/CODA-user-manual.pdf
http://www.eumetcast.com/
https://coda.eumetsat.int/
https://codarep.eumetsat.int/
https://gitlab.eumetsat.int/eumetlab/cross-cutting-tools/sentinel-downloader
https://gitlab.eumetsat.int/eumetlab/cross-cutting-tools/sentinel-downloader
http://archive.eumetsat.int/
http://eumetview.eumetsat.int/
https://wekeo.eu/
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Figure 6: Choosing OLCI datasets within the EUMETSAT Data Centre. 
 
For those who are members of the S3VT, see Section 4.5, there is also FTP access via the ODA 
that allows you to access both datasets and minifiles. Minifiles are products extracted over 
small areas of interest and provided in the standard SAFE format. 
 

7.4 Software Tools 

7.4.1 Sentinel-3 Toolbox 

The Sentinel-3 Toolbox consists of visualisation, analysis and processing tools for the 
exploitation of OLCI and SLSTR data, and is an extension to the SeNtinel Application Platform 
(SNAP) that can be downloaded from the Science Toolbox Exploitation Platform (STEP)7.  
 
Once SNAP has been downloaded and installed it is possible to open L1 and L2 OLCI products. 
If you need questions answered about the SNAP tool and associated Sentinel toolboxes then 
there is an on-line forum8.  

7.4.1.1 Installing the toolbox 
To install SNAP, click/double-click the installer and follow the on-screen instructions to install 
SNAP. 

7.4.1.2 Opening a Sentinel-3 product 
Sentinel-3 products are provided not as single files but as a product package containing a 
collection of files, the package is a folder. The folder name is the actual product name, ending 
with “.SEN3”. Each folder contains a metadata file named xfdumanifest.xml and at least one 
netCDF file. Each netCDF file contains a subset of a Sentinel-3 product's content. 
 
To open a Sentinel-3 product you can either: 

• Drag and drop the whole folder into the "Products View" 
• Drag and drop the xfdumanifest.xml file into the "Products View" 
• Choose "File->Open Product", navigate to the xfdumanifest.xml file and click "Open 

Product" 
• Choose "File->Import Raster Data->Multispectral Data->SENTINEL-3", navigate to 

the xfdumanifest.xml file and click "Open Product" 

                                                   
7 STEP download page: http://step.esa.int/main/download/  
8 STEP forum: http://forum.step.esa.int/ 

http://step.esa.int/main/download/
http://forum.step.esa.int/
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You can also open single netCDF files. However, keep in mind that this will provide a generic 
netCDF access without associated information about geocoding, flags and other functionalities. 
This is particularly important for OLCI data. 
 
Guidance on opening and working with OLCI data in SNAP is available in a youtube tutorial: 
https://www.youtube.com/watch?v=V3NAuafvlFM&t=1s  
 
 

7.4.1.3 Basic functionality 
Once you have opened a product in SNAP there are many different things you can do next. 
Here are some basic activities: 

• Displaying a colour composite: choose "Window->Open RGB Image Window". 
• Displaying spectra, choose "Optical->Spectrum View". 
• Displaying flags/masking the data: using the Mask Manager, see example in Section 

8.2.3. 
• Displaying pixel values, geolocation etc... 

7.4.2 METIS  
The Monitoring & Evaluation of Thematic Information from Space (METIS) tool9 provides 
near-real time diagnostics of EUMETSAT’s operational L2 and Level 3 (L3) optical products. 
Ocean Colour functionality will become available in the near future. 

                                                   
9 METIS: http://metis.eumetsat.int/  

https://www.youtube.com/watch?v=V3NAuafvlFM&t=1s
http://metis.eumetsat.int/
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8 DATA QUALITY 
With Sentinel-3 being an operational mission, three main objectives were defined for the 
Cal/Val activities [RD-15]:  

a) To provide a comprehensive initial assessment of product validity and quality at the 
end of commissioning activities. 

b) To monitor the stability and the quality of the products throughout the operational phase 
of the mission. 

c) To continuously improve the quality of the products in accordance with the evolving 
user requirements.  

 
OLCI mission requirements are documented in ‘Sentinel-3: Mission Requirements Document’ 
[RD-33].  
 
Algorithm evolutions, validation results and product quality are provided in OLCI L2 
Collection reports and the summary is given in Product Notices available from 
https://www.eumetsat.int/ocean-colour-services. The recent Collection 3 report is also 
available https://www.eumetsat.int/media/47794 [RD-24].  
 
In addition, the Global Climate Observation System (GCOS) has identified ocean-colour as an 
Essential Climate Variable (ECV) with the GCOS Implementation Plan [RD-23] defining the 
following set of ocean-colour requirements for climate research; see Table 8. 

Table 8: GCOS ocean-colour requirements for accuracy and stability 

Requirement category Ocean-colour 
requirement 

Water-leaving radiance uncertainty  (blue & 
green wavelengths) 

5.0 % 

Water-leaving radiance stability per decade 0.5 % 

Ocean chlorophyll-a uncertainty 30.0 % 

Ocean chlorophyll-a stability per decade 3.0 % 

 
 
Information on the current status of data quality from the OLCI instruments aboard Sentinel-
3A and B, can be found in the data product quality reports: 
 
 https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-olci/data-quality-reports 
 
and through the Sentinel-3 Validation Team activities (https://s3vt.org/). 
 
 
 

https://www.eumetsat.int/media/47794
https://sentinel.esa.int/web/sentinel/technical-guides/sentinel-3-olci/data-quality-reports
https://s3vt.org/
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9 UPDATES TO PROCESSING BASELINES AND REPROCESSING 
CAMPAIGNS 

Periodic improvements to the processing of OLCI data are made and reflected in changes to 
the processing baseline. These changes are accompanied by product notices that describe any 
impacts on the data at level 1 and/or 2. The product notices can be viewed here: 
https://www.eumetsat.int/ocean-colour-services 
  
Data are periodically reprocessed using the current baseline and this data is distributed via 
https://codarep.eumetsat.int. Details on the reprocessing can also be found in the product 
notices at the link above. 
 
A diagram summarising the changes to the processing baseline and reprocessing campaigns 
since the launches of Sentinel-3A and B, is provided below. Further details are summarised at 
the following link: 
 https://www.eumetsat.int/olci-processing-baselines  
 

 

 

Figure 7: OLCI processing baseline changes and reprocessing campaigns since launch. 

https://codarep.eumetsat.int/
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10 FREQUENTLY ASKED QUESTIONS 
Please email any questions to the EUMETSAT User Helpdesk at ops@eumetsat.int. 
 
Additional information around topics of frequently asked questions is provided below. These 
include questions on: 

• Data characteristics: camera discontinuities, South Atlantic anomaly, and sun glint. 
• Handling the data: using netCDF, calculating TOA reflectance, and applying flags. 

10.1 OLCI data characteristics 

10.1.1 Camera-to-camera discontinuities 
Like with MERIS, you may see boundaries between the 5 cameras within the L1 products, and 
occasionally in L2 data. This is primarily due to the smile effect that causes small variations in 
the TOA radiances due to slight changes in central wavelengths across the CCDs in the 
cameras. This effect is visible at L1. At L2, the smile correction is applied which brings all 
pixels across the cameras’ FOV to the nominal instrument centre wavelengths for each band 
and the effect should be minimized.  
 
As the central wavelength is not constant within a L1 scene, the wavelength is provided as an 
array for each band in the file instrument_data.nc (lamda0 and FWHM groups); see Figure 8. 
 

  

Figure 8: Example arrays of (left) lamda0 and (right) FWHM for band Oa1. 
 

10.1.2 South Atlantic Anomaly 
The South Atlantic Anomaly is an area where the Earth's inner Van Allen radiation belt comes 
close to the Earth's surface, which exposes orbiting satellites to higher-than-usual radiation 
levels. For OLCI, this is visible in all bands but particularly in the wider bands, like Oa21, 
where radiation hitting the CCD is visible as single pixel noise in an image; see Figure 9 which 
shows an OLCI scene captured over Argentina.  
 

mailto:ops@eumetsat.int
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Figure 9: Subset of a Sentinel-3 FR scene with (top left) SNAP’s World View and (top right) TOA Tristimulus 
RGB colour composite with the South Atlantic Anomaly as visible in (bottom right) the TOA band Oa21 
radiance and (bottom left) atmospherically corrected data (Tristimulus RGB colour composite). 

10.1.3 Sun glint affecting the right-hand side of scenes 
OLCI was designed to be tilted to avoid Sun glint, and so has reduced glint contamination 
compared to MERIS. However, sun glint is not completely avoided. Therefore, you will see it 
in scenes where there is water; such as in Figure 10. 
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Figure 10: Example L1 scenes showing sun glint down the right-hand side of the scene. 

 

10.1.4 OLCI anomalous spectral samples 

Anomalously low radiances have been identified in OLCI Level-1B products at the edges of 
bright, saturated areas. These low radiances occur in some bands and do not correspond to 
geophysical expectations. The anomalies are present over bright clouds in both OLCI-A and 
OLCI-B.  No impact on OLCI operational Level-2 products has however been determined 
because L2 products are not available over bright surfaces. More detailed description of the 
anomaly is available from here https://www.eumetsat.int/media/47581.   

10.1.5 Anomalous low water reflectances in the NIR for waters with low-to-moderate 
TSM values 

It has been observed that standard Level 2 water reflectances in the NIR show lower values 
when compared to in situ data in the range [0 – 0.005]. This issue is under investigation.  

10.1.6 Open issues and future improvements 
Known issues with the OLCI processing are highlighted in each of the product notices that 
accompany new process releases (see https://www.eumetsat.int/ocean-colour-services). A 
summary of open issues and future improvement plans is provided in [RD-24] with reference 
to the latest baseline collection (OL_L2M.003) at https://www.eumetsat.int/media/47794.  
 

10.2 Handling the data 

10.2.1 How to view the contents of a netCDF file? 
 
If you want to browse the detailed contents or metadata of a netCDF file (as opposed to visually 
looking at and interrogating the array in SNAP) then there are interactive tools such as 
Panoply10 alongside Linux commands such as ncdump. There is a tutorial showing how to 
access netCDF files using Python programming here: 
 

                                                   
10 Panoply download: https://www.giss.nasa.gov/tools/panoply/  

https://www.eumetsat.int/media/47581
https://www.eumetsat.int/ocean-colour-services
https://www.eumetsat.int/media/47794
https://www.giss.nasa.gov/tools/panoply/
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 https://www.youtube.com/watch?v=XqoetylQAIY 

10.2.2 How would I calculate the Top of Atmosphere Reflectance from a Level 1 
product? 

 
The solar irradiance provided in the L1 products varies throughout the year. It is computed for 
each product, in order to represent the solar irradiance at the Earth due to the Earth orbit 
eccentricity around the sun at the current date i.e., the modelling of the seasonal variations is 
included. Therefore, the OLCI TOA reflectance can be obtained by dividing the L1 TOA 
radiance by the solar irradiance in the L1 product and by the cosine of the SZA (Cosine Rule), 
and multiplying by π (if assuming a Lambertian upwelling radiance at TOA). 

10.2.3 Which Level 2 flags should I apply? 
 
Table 9 contains the definition of user recommended flag combinations for masking of cloudy 
and unreliable pixels in OLCI Level-2 Ocean Colour products from Collection OL_L2M.003 
[RD-24]. 
  
Users are advised to apply the flag recommendations from Table 9. Implementing the 
recommendations is central to the traceability of OLCI L2 product status across applications 
and the validation process. This flag recommendation is particularly important for large scale 
analyses and automated processes. It is understood that advanced users would want to 
experiment with application of flags that suit their particular local region or application. 
However, it is advised that, at the same time, the results based on the recommended flags are 
also reported. 
 
Figure 11 shows an example of a scene with this masking applied. 
 
 
 
 
  

https://www.youtube.com/watch?v=XqoetylQAIY
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Table 9: Recommended L2 flags for masking unreliable or bad pixels 

 
Product names Products Common flags Processing chain 

flags Product flags 

Water reflectance  
– BAC Open 
Waters  

Oa**_reflectance → 
Oa**_reflectance 

Ocean Colour Products 
 
(WATER or 
 INLAND_WATER)  
and  not  
(CLOUD  
CLOUD_AMBIGUOUS 
CLOUD_MARGIN  
INVALID  
COSMETIC  
SATURATED  
SUSPECT  
HISOLZEN  
HIGHGLINT  
SNOW_ICE) 

Baseline 
Atmospheric 
Correction  
Open Water 
Products 
not  
(AC_FAIL  
WHITECAPS  
ADJAC  
RWNEG_O2  
RWNEG_O3  
RWNEG_O4  
RWNEG_O5  
RWNEG_O6  
RWNEG_O7  
RWNEG_O8) 

none 

Algal pigment 
concentration 
– BAC Open 
Waters 

chl_oc4me → 
CHL_OC4ME 

not    
OC4ME_ FAIL 

Diffuse 
attenuation 
coefficient  
– BAC Open 
Waters 

trsp → KD490_M07  not   
KDM_FAIL 

Photosynthetically 
Active Radiation 
– BAC Open 
Waters 

par → PAR not    
PAR_ FAIL 

Aerosol Optical 
Thickness and 
Ångström 
exponent 
– BAC Open 
Waters 

w_aer →  T865, 
A865 none 

Algal pigment 
concentration  
– AAC Complex 
Waters 

chl_nn → CHL_NN  

Alternative 
Atmospheric 
Correction  
Complex Water 
Products 
 
no specific flags to 
be applied 

not   
OCNN_FAIL 

Total suspended 
matter 
concentration  
– AAC Complex 
Waters 

tsm_nn → TSM_NN not   
OCNN_FAIL 

Coloured Detrital 
and Dissolved 
Material 
absorption  
– AAC Complex 
Waters 

iop_nn  → 
ADG443_NN 

not   
OCNN_FAIL 

Integrated Water 
Vapour Column iwv → IWV Atmospheric Products Water Vapour  

not MEGLINT not    WV_FAIL 
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Figure 11: Example (top) L1 scene (bottom) L2 equivalent with the recommended L2 flags applied. 
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